
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Guide to Kindle Formatting & 
Publishing 

John S. Rhodes and Jay Boyer 



 

© Copyright J. J. Fast Publishing, LLC. All Rights Reserved. This guide may not be reproduced 
or transmitted in any form without the written permission of the publisher. Every effort has 
been made to make this guide as complete and accurate as possible. Although the author and 
publisher have prepared this guide with the greatest of care, and have made every effort to 
ensure the accuracy, we assume no responsibility or liability for errors, inaccuracies or 
omissions. Before you begin, check with the appropriate authorities to insure compliance with 
all laws and regulations. 

This report has been written to provide information to help you write, publish, and promote 
your books to Amazon.com. JJ Fast Publishing, LLC is in no way affiliated with Amazon.com. 

Every effort has been made to make this report as complete and accurate as possible. 
However, there may be mistakes in typography or content. Also, this report contains 
information on online marketing and technology only up to the publishing date. Therefore, this 
report should be used as a guide – not as the ultimate source of Internet marketing 
information. 

The purpose of this report is to educate. The author and publisher does not warrant that the 
information contained in this report is fully complete and shall not be responsible for any errors 
or omissions. The author and publisher shall have neither liability nor responsibility to any 
person or entity with respect to any loss or damage caused or alleged to be caused directly or 
indirectly by this report, nor do we make any claims or promises of your ability to generate 
income by using any of this information. 



Contents 
Get Your Book Ready ........................................................................................................................... 5 
Kindle Formatting Rules ....................................................................................................................... 6 

First- Some Best Practices ........................................................................................................................ 6 
What Kind of File? .................................................................................................................................... 7 
Build Your Book in Word .......................................................................................................................... 8 
Layout ...................................................................................................................................................... 8 
Leave These Out ....................................................................................................................................... 8 

Headers, Footers, and Page Numbering ....................................................................................................................... 8 
Bullets, Special Fonts, and Character Formatting .......................................................................................................... 9 
Color Isn’t Necessary ................................................................................................................................................... 9 
No Drop Caps ............................................................................................................................................................... 9 
Choosing Your Font & Font Size ................................................................................................................................... 9 

Adding A Table Of Contents ................................................................................................................... 10 
Start Chapters on A New Page ............................................................................................................... 11 

Calibre Options .......................................................................................................................................................... 12 
Other Options ............................................................................................................................................................ 12 

Using Links ............................................................................................................................................. 13 
Using Images In Your Kindle EBook ........................................................................................................ 13 

Using Word Styles .............................................................................................................................. 15 
Turn on the Hidden Symbols .................................................................................................................. 15 

How to Use the Template .................................................................................................................. 19 
A Word About Your Cover Image ........................................................................................................... 19 
Conversion With Calibre ......................................................................................................................... 20 

Select Your Options ................................................................................................................................................... 22 
Conversion With Kinstant ....................................................................................................................... 26 
Preview Your Book before Uploading ..................................................................................................... 28 

Publishing Your Kindle eBook ............................................................................................................. 29 
Sign In and Update Account Information ............................................................................................... 29 
KDP Select .............................................................................................................................................. 30 
Enter Your Book Details .......................................................................................................................... 32 
Rights, Royalties and Pricing .................................................................................................................. 35 
How Should You Price Your Book? ......................................................................................................... 37 

Conclusion ......................................................................................................................................... 39 
Recommended Resources .................................................................................................................. 40 

The Kinstant Formatter .......................................................................................................................... 40 
Promoting Your Book ............................................................................................................................. 40 
Niches For Books .................................................................................................................................... 40 
Advanced Kindle Training/Case Studies ................................................................................................. 40 
Legal ....................................................................................................................................................... 41 
Other ...................................................................................................................................................... 41 

Amazon’s Resources .................................................................................................................................................. 41 
Press Release Sites ..................................................................................................................................................... 41 
Free Information, Tools and Resources ...................................................................................................................... 42 

Disclosures and Disclaimers ............................................................................................................... 43 



Limits of Liability & Disclaimers of Warranties ........................................................................................................... 43 
 



Get Your Book Ready 
 

This report doesn’t cover the mechanics of writing your book. It is assumed that you have the 
book content already, and just need to know how to get it from your computer to live on 
Amazon, in the easiest way possible. 

In addition to your book’s content, you should think about the front and back matter you wish 
to add to your book. These are the pages that come before and after your content. 

Front and back matter options include: 

• Title Page* 
• Copyright Page* 
• Dedication or Acknowledgements 
• Table of Contents* 
• Preface 
• Afterword 
• Appendices (this could include a resources section) 

The items with the asterisk are pretty much must-haves. The others are optional, but using a 
resources section in your eBook is a great way to generate leads or traffic to a website. 



 

Kindle Formatting Rules 
 

You’ve probably heard horror stories about formatting Kindle books, and you may think that 
there is a high level of skill involved in getting it right. The truth is, it really isn’t difficult at all; 
you just have to know the rules. The biggest rule to remember as you go through this guide is: 
with Kindle, less is more! If in doubt, leave it out. 

This guide will give you the rules, and walk you through the steps to implementing the tools. 
With this self-publishing tool box, you also received a Kindle template. You don’t have to use a 
template to get a great-looking Kindle book, but since some of the formatting steps are already 
set up for you, it makes it a little easier. 

First- Some Best Practices 

If you don’t follow a few simple “best practice” rules, you can totally blow the formatting on 
your Kindle book, and kill sales. Some of these will be covered in a bit more detail later, but for 
now, here are some things to remember when formatting your Kindle eBook. 

Learn to use styles. Word’s Style feature allows you to set the font, paragraph spacing, and 
other specifics collectively to a group of text. Styles can save a lot of time in formatting a book, 
and it helps to ensure consistency. Styles will also help to prevent some of the “messy” 
formatting that plagues so many Kindle eBooks. 

Start your chapters on a new page. Just like in a print book, Kindle chapters should start on a 
new page. If you use a Heading style for chapter titles and convert with Calibre, this will be 
done for you. 

Less is more. The main thing to remember when formatting for Kindle is to leave out any 
“special” formatting. Also, no page numbers, headers, footers, bullets, etc. 

Don’t over-indent. If you're indenting certain portions of text to create emphasis, don’t overdo 
it. The Kindle viewing area is small; too much indent and you won’t leave much room for your 
text. 

Use the right font. Use a "serif" type font such as Times New Roman in about a 12 pt. size. For 
Headings, etc. never go larger than 18 pt. 

Have an attractive cover. Looks do matter, and people do judge a book by its cover. Take the 
time to create an attractive cover. If you aren’t skilled with designing graphics, then hire 
someone to do it for you. It will be well worth it in the long run. 

Finally, take a look at what’s already available in the Kindle marketplace. Look at the best sellers 
lists and see what works. No need to re-invent the wheel. 



What Kind of File? 

Believe it or not, I’ve uploaded Microsoft Word .doc files directly to the Kindle platform, and 
they turned out just fine, so that is certainly an option. (I’ve been told that .docx won’t work, 
but I’ve never personally tried.) 

You can upload HTML files directly to the Kindle platform as well. To create a .html file of your 
Word document, simply do a Save As > Web Page, Filtered. Either upload that directly to Kindle, 
or use it to create either of the next two options. 

The file format that you hear most widely recommended is the PRC format that’s created using 
a conversion tool called Mobipocket Creator. PRC is what you see mentioned on the Kindle 
platform. The reason for that: Amazon owns Mobipocket. In reality, a PRC file is the same as a 
MOBI file, and I like a different conversion tool for that. 

My personal choice among the free options is something called Calibre. Calibre is much more 
than a conversion tool. It’s an eBook library management tool. I won’t go into all that it does, 
but I’ll show you how to use it to make a MOBI file in a later chapter. If you’d like to know more 
Calibre’s features, there’s a great free guide about it here: Make Use Of Calibre Guide. 

 

So, Word Document, HTML, PRC, MOBI: any of these file formats will work, as long as you get 
the formatting right. 

Word of caution: Don’t try uploading a PDF to the Kindle platform. That is one format that 
WON’T convert properly. 

So why do people convert Word files if you can upload them directly? Part of the reason is so 
that you can preview the final product the way it will be seen on a Kindle, and see where your 
formatting issues might be. I can’t tell you how many manuscripts I’ve looked at that were 
riddled with messy formatting that would cause seriously bad-looking Kindle books. 

I said that Calibre is my favorite free conversion tool. It still is, but I have recently started using 
a new, low-cost option called the Kinstant Formatter. Even though it’s called a formatter, it’s 
really more of a conversion tool, but it’s a powerful one. You do still need to have your Word 
document formatted correctly, according to the rules in this guide, and the template that you 
received with this kit is perfect for getting started. 

The difference between using Kinstant and Calibre, is that the Kinstant software takes out the 
step of having to convert your Word document to HTML. It will insert your cover image, and 
create your table of contents. Kinstant is also a little more forgiving than most conversion tools 
if you don’t get your formatting perfect. The Kinstant Formatter is by far the easiest option I’ve 
used for converting an eBook to a MOBI file for Kindle. 

Check the Resource section at the end of this guide for more information about the Kinstant 
Formatter. 



NOTE: If you are using Word for Mac or Open Office, the steps to save as an HTML file are 
different. In Open Office, there is no Web Page, Filtered option at all; you just have to save as 
HTML. 

In Word for Mac, you can do a Save As > Web Page. Then on the save screen, select the option 
that says “Save only display information as HTML.” 

Build Your Book in Word 

I use Word to create my Kindle books, and the instructions here will be for Word 2010. If you 
use a different version of Word, or if you have Open Office instead, your steps will be slightly 
different. 

Be sure to save your work often, because nothing is more frustrating than spending an hour 
formatting your book and then losing it because your computer crashes. If you plan to upload 
the Word file directly, be sure to do a “Save As” if you’re using 2010 because if you save 
normally, you’ll get the .docx file, when what you want is .doc. 

Once you’re completely finished with your formatting, you should do a Save As - Web Page, 
Filtered if you plan to convert the eBook using Mobipocket or Calibre. (This step is not 
necessary if you are using Kinstant.) 

 

 

Layout 

In the provided Kindle Template, a block paragraph style is being used for the eBook content by 
applying the Normal paragraph style. 

A Block paragraph style is one that does not have the first line of each paragraph indented. 
Instead it uses some space after the last line of a paragraph to provide separation. If you prefer 
to use paragraph indents instead, feel free to change the style settings to that option. 

If you’re going to use the indented style, then you will want to set it no larger than 0.3”.0.3” is 
the standard when adding a first line indent on your paragraph style(s). Under no circumstances 
should you ever go higher than a 0.5” indentation setting. It can cause errors or look crazy 
when viewed on a Kindle device. 

The important thing to remember is to only use one or the other, not both, when you are 
making your eBook(s) ready for Kindle conversion. We will discuss how to make changes to 
style settings a little later on. 

Leave These Out 

Headers, Footers, and Page Numbering 
Headers, footers, and page numbers don’t translate on Kindle readers so you shouldn’t waste 
time adding them. You shouldn’t use page numbers in the Table of Contents either. Part of the 
reason for this is that different devices have different dimensions, and the user is able to adjust 
font as well. The reading experience is “dynamic” and page numbers just don’t apply. 



KINSTANT NOTE: If you use the Kinstant Formatter, it will remove any headers, footers, and 
page numbers for you. It will also auto generate your TOC based on your heading styles. 

Bullets, Special Fonts, and Character Formatting 
You can use bold, italics, and heading styles, and they will translate into your Kindle book. You 
can also use indents, both left and right to emphasize certain content. Just remember that the 
Kindle screen is small, so don’t go too drastic with the indents, or it will look strange. 

Bullets, special characters, and special fonts will not translate. You’ll need to remove those. You 
also should not use tabs. Instead use indents as mentioned above. 

KINSTANT NOTE: If you use the Kinstant Formatter, you can use bullets, because it will improve 
the appearance of your bullet points. It will also remove tabs and extra lines. 

Color Isn’t Necessary 
Color isn’t available on most Kindle readers, with the exception of the new Kindle Fire. For the 
most part, Kindle readers display in grayscale only. 

So if you normally use colors to highlight your different chapter and sub-chapter levels, you’ll 
want to go a different route for Kindle. You can use a slightly larger font, or a slightly different 
font, use a combination of serif and sans serif fonts, or use bold or italic. 

Kindle does encourage the use of color in your images, because of the ability to see color on the 
newer devices. 

No Drop Caps 
In a lot of my print books, I use drop caps to set off the beginning of a paragraph. It gives a 
more professional look to the interior design of the book. Drop caps won’t translate well at all 
on a Kindle book, however. 

If you want the effect, you can simulate a drop cap style by manually adjusting the font on the 
first letter of the chapter. Just use a size larger font, and bold it. For example: 

This is how you can achieve a drop cap look, without using formatting that Kindle doesn’t like. 
The first letter “T” above has a 14pt size setting and has been bolded. 

KINSTANT NOTE: If you use the Kinstant Formatter, and have drop caps in your document, it 
will convert them to the effect described above. 

Choosing Your Font & Font Size 
Kindle will over-ride any font you use, but some other readers may not. Because of that, when 
formatting for any eReader device, it’s best to stick with the most common serif fonts. For 
example: Times New Roman, or Georgia. Sans serif fonts are not recommended. 

To simplify, Times New Roman set at about 12pt will be the closest match to what your readers 
will be seeing on their Kindle screen. 



The largest you should go with any font size (for headings) is 18pt. Nothing larger than that as 
it could cause problems and may even result in rejection from Amazon. 

Adding A Table Of Contents 

I’ve read a lot of conflicting information about adding a TOC to your Kindle books, but one thing 
is clear. Readers prefer that you have a TOC and having one that links to the chapters in your 
book is preferred. Being able to easily navigate your eBook provides a better reader experience. 

There are two ways to add a functioning TOC to your Kindle book. There is the manual way, and 
the automatic way. 

The manual way is to create bookmarks throughout your eBook for each chapter, and typing 
out and hyperlinking your TOC list manually. 

To insert bookmarks, you would simply place your curser at the chapter or sub-chapter heading 
and click on Insert > Bookmark. Then name your bookmarks something like c1, c1a, c2, etc. 

You’d then go to the beginning of your document and type out your list of chapter titles. On 
each one, highlight and right click, select Hyperlink, select Place in this Document, and choose 
the bookmark that corresponds with each. 

The automatic way is to just go to References>Table of Contents>Insert Table of Contents. The 
default setting for the TOC is to show page numbers AND hyperlink them. For Kindle, you’ll 
want to uncheck the Show page numbers box, since we don’t use page numbers in Kindle 
books. 

In your template, the automatic TOC has been inserted. After you enter your content, you can 
just right click anywhere in the TOC and click update field, and it will update your TOC for you. 

A lot of people have claimed that the manual way works best, but I’ve never had a problem 
with using the automatic TOC. I’ve generated a lot of Kindle books using the automatic method, 
and converting with Calibre, and they have all worked just fine for me. 



 
 

Some MAC users have informed me that Word for MAC just won’t generate a hyperlinked TOC 
based on styles. I’ve also heard that Open Office sometimes has issues with it. Fortunately, the 
two conversion tools I recommend will both help with that problem. 

CALIBRE NOTE: In Calibre, even if you have a TOC in your eBook, by default it will generate a 
second TOC and place it at the end of your book content. A lot of people thought that this was 
an error in Calibre but actually it’s deliberate. It’s Calibre’s attempt to do a metadata TOC. 
Rather than try to explain it all to you, I’ll just give you the link to the FAQ on Calibre’s site 
where they explain it: 

http://manual.calibre-ebook.com/faq.html#id17 
 

That can be turned off however, or you can use it as your actual TOC and have it moved to the 
front of your eBook. I’ll explain how to do that a little later. 

KINSTANT NOTE: Kinstant will create your TOC based on heading styles. There is an option 
before conversion to: Add/Replace TOC. Just check that and you have a hyperlinked TOC. It 
doesn’t get any easier than that. 

Start Chapters on A New Page 

In any book, Kindle or physical, it’s always better to have your chapters start on a new page. 
There are a few different ways you can do this. If you use Heading styles and plan on using 



Calibre to convert your Web Filtered HTML file into a MOBI file for Kindle, then you don’t have 
to worry about doing it manually, although I do recommend that you do anyway. 

Calibre Options 
Each time you use the Heading 1 or Heading 2 style in your eBook, Calibre will auto generate a 
new page break. This can be problematic, because you do want the page break before Heading 
1, but not before Heading 2. If you are using Calibre, you have two options. The first is to use 
only one Heading style for your paragraph titles (either H1 or H2.) For other subchapter titles, 
you can simply bold the text; make it a bit larger than the rest of your content, etc., but leave 
the Normal style in place on these subchapter headings. 

If you use that option, it means that your TOC won’t show subchapters. If you have lots of 
Chapters, Subchapters, and Sub-subchapters, that might be ok with you. You probably don’t 
want a huge TOC in a Kindle book anyway. The main chapter titles might be enough. 

If you feel that your book really must have the subchapter titles in the TOC, then one way 
around it would be to use the Emphasis style for subchapter headings. That will make the 
subchapter heading stand out, and it will show up in your automatic TOC, but Calibre won’t 
recognize it as a heading. 

Of course, if you want to used Calibre’s auto-generated TOC, then that wouldn’t really work, 
would it? So fortunately, the other option is to turn off the page break before H2 titles. I will 
show later how to change this option in Calibre. 

Other Options 
If you are not using Calibre, you need to set your own page breaks. The best way to begin your 
chapters on a new page is by adding the “Page break before” function to the Heading style. You 
can do this by modifying the style. (Instructions for modifying styles will be discussed a little 
later.) 

One final way to is to manually add page breaks. I would not recommend using this method 
when generating a MOBI file with Calibre, because you would probably end up with a double 
page break. Calibre would not see that manual page break as belonging to the H1 title, and it 
would honor your page break AND create one for your chapter title. If you use Kinstant, manual 
page breaks are fine. 

To manually add a page break, you want to place your cursor in front of your chapter title. Once 
that’s done, you want to click the Insert tab/link on the main Word ribbon. From there, click the 
Page Break icon/link (this should be near the far left of the ribbon). Then a new page is added 
with your chapter beginning at the top of the new page. (Or you can use the keyboard shortcut: 
Control+Enter.) 

If you are writing out your eBook content as you go along, you can also insert the Page Break 
immediately following the last sentence of the chapter. Then begin your next Chapter on the 
new page. 



WARNING: Be mindful of what links you put inside your Kindle book, if you don’t want to be 
banned. Here is a quote from Amazon’s TOS regarding Kindle books: 

“You may not include in any Digital Book any advertisements or other content that is 
primarily intended to advertise or promote products or services.” 

Interpret that how you will, but my answer is always: if in doubt, ask Amazon! People get so 
paranoid about “staying under the radar” that they often end up getting banned for mistakes 
that could have been prevented by asking a simple question. Don’t be that person. 

You should only use page breaks for the beginning of new chapters. Don’t force a page break to 
make certain content fit on a certain “page.” Remember that pages are not relevant in Kindle. 
Kindle devices have different screen sizes, and users can also resize font so what you see on 
your computer monitor is not necessarily what they will see on their device. So ignore the 
“widows and orphans” for Kindle! 

Using Links 

If you wish to add a link into your eBook(s), the best way is to type your text that you want to 
be linked, then highlight it, right click and select Hyperlink from the box that pops up. Be sure 
that Existing File or Web Page is selected in the menu on the left, and in the Address section 
type out the full link. Don’t forget to include the “http://” part to the beginning, or the link 
won’t be clickable. 

I’ve never had a problem getting my links to function, but some people say that they have. If 
you do have a problem, you can always type the link out so that your reader can manually type 
them into a browser. It may not be as attractive as using anchor text for your links, but it will at 
least give them the URL. 

 

 

Using Images In Your Kindle EBook 

There is nothing wrong with inserting images in your Kindle eBook, as long as it adds value to 
the book. Don’t add images just for the sake of adding them. If you do add images, just be sure 
to insert them correctly into your eBook, don’t just copy-paste. 

Go to Insert>Picture and then browse to the image you want on your computer and select it. 
 



Note: Transparent PNG images aren’t supported. I know that some people have had some 
success using transparent images with Calibre, but in general, they aren’t the best option. I 
know that Kinstant had problems with transparent PNGs. A solution is being researched, but for 
now, the recommended format is as stated above. 

You should use the “In Line With Text” setting for your images. If you want to center your 
image, after it has been placed where you want it, click the Center option on the ribbon from 
the Home section. 

Another important point about images is their resolution. Kindle prefers images at a higher 
resolution; they ask that you use 300 dpi. . They say that supported image formats are GIF, 
BMP, JPG and PNG, and sizes up to 127 kb. 

Recommended formats: photos should be JPG with a quality factor of 40 or higher; minimum 
size 600x800. Line art should be GIF; maximum size 500x600. 

 



 

Using Word Styles 
 

So far, I’ve been telling you to use styles instead of manual corrections. That’s because things 
like hard returns (where you have hit your Enter key multiple times,) tabs, and other similar 
things that we often do when typing a Word document can mess up the look of a Kindle eBook. 

In order to make sure that you get all of that messy formatting out; you first need to find out 
where it is. 

Turn on the Hidden Symbols 

To see where everything is located, like the positions of Page Breaks, paragraphs, spaces, etc. 
you will want to find the icon in the main Word ribbon that looks like a backwards “P.” (There is 
a similar-looking symbol in Open Office that does the same thing.) 

 

Click it. Now you will see all sorts of strange symbols throughout this template. Those symbols 
indicate where specific elements are located, and what they are. 

Go through and remove things that shouldn’t be there. Hard returns are considered 
paragraphs, and will also show up as a backwards “P.” There should be one at the end of each 
paragraph. There will also be one with a little dotted line that says Page Break where you have 
your Page Breaks. Any others should be removed, as well as any bullets, tabs etc. 

When you don’t want, or need to see the formatting symbols anymore, just click the backwards 
“P” symbol again. 

Modifying Styles 

You can make adjustments to any of the style settings on the Home ribbon in Word by using 
right clicking on that style and selecting Modify. You will then see a screen like this: 



 
 

The font information for the style is on that view, and if you click on the format button and then 
select paragraph, you can make additional adjustments. 

On the Indents and Spacing tab, you can adjust alignment, indentation, line spacing and spacing 
before and after the paragraph. 

On the Line and Page Breaks tab is where you can select the Page break before option for your 
headings. 

I’ve told you that you can’t use hard returns to space between paragraphs, but sometimes you 
need a little extra space. So what do you do? It’s pretty easy, really. Just highlight the section 
that you need space added to, right click, select Paragraph and adjust the space before and/or 
after on the Indents and Spacing tab. 



 
 

You can use this to adjust spacing before and after paragraphs, headings, or even single lines. 
Whatever text you highlight will be considered the “Paragraph” you are adding space to. 

You can also make changes to just certain parts of a document. For example, you use Normal 
style for the main content of your book. Normal settings include the spacing that’s assigned 
before and after each paragraph, the indents, etc. 

If you want just a portion of the content to have different settings, just adjust those by using 
the right click – Paragraph method. If you make an adjustment that you decide you want to 
have applied to the entire document you can easily do that too. 



If, for example, you decide that you may want to add italics to a Heading 3 style, you can 
highlight and italicize one of your subchapters that uses the Heading 3 style, just to see how it 
looks. If you decide you like it, then just right click on the Heading 3 style on the Home ribbon, 
and click on Update Heading 3 to match selection. This will change all of the Heading 3 titles 
throughout the book. 

Open Office uses styles as well, but the menu is a bit different. Just go to the menu bar at the 
top, click on Format > Styles and Formatting. You’ll get a little box that pops up on the side of 
your screen with a list of the styles for your document. Right click on any of those and click 
modify, and you can change the settings to what you need. 



 

How to Use the Template 
 

Using your Kindle Template is easy. I will outline the steps you need to take below. You may 
want to save a copy of the template and use that, so that you keep the original file intact. 

The page size and margins of the template are set to mimic how the eBook will look on the 
Kindle screen. You can change these if you want, because page size really won’t matter when 
you upload to KDP. 

Replace placeholder content with your own. You can cut and paste, or type directly into the 
template. If your content is already properly formatted in another document, you can cut and 
paste the entire thing into the template at once. Otherwise, it’s best to do it one chapter at a 
time. Be sure to clear out any messy formatting. 

Be sure ALL main chapters and subchapters use the Heading styles found inside the Word main 
ribbon, unless you are going to use Calibre without modifying the heading page breaks. In this 
case, you would only use one of the Heading styles for your main chapter titles. 

The template is set up with the following: main chapters = Heading 1, subchapters = Heading 2, 
sub-subchapters = Heading 3. 

The Heading 1, Heading 2, and Heading 3 styles are pre-set to be larger in size to separate them 
from the rest of the eBook contents. The bold option has also been applied, and the italics 
option has been applied to the Heading 2 style as well. Feel free to modify any of the existing 
styles in any way you wish. 

Don’t forget to update the TOC (Table of Contents) after you have finished making your 
adjustments, adding your content, etc. Do this by going up to the TOC, right clicking anywhere 
within it, then clicking Update Fields in the box that pops up. 

There are 2 bookmarks in place in the template. They are placed specifically so that Kindle 
knows where your TOC and the beginning of your eBook are located. The positioning of those 2 
bookmarks are right above the TOC and also right above Chapter 1. You shouldn’t remove these 
bookmarks, but you may reposition them if you like. 

Save your file. Be sure to save your new Word file as a .doc file ONLY. Remember, Amazon 
doesn’t like the .docx extension in newer versions of Word from 2007 and up. If you are using 
Kinstant, .docx is okay to use. If you plan to use Calibre or Mobipocket, save also as a Web, 
Filtered file. 

A Word About Your Cover Image 

The template has a placeholder cover image already inserted. If you are planning to use 
Kinstant Formatter, you should remove the cover image completely. Kinstant uploads that 
separately from the book file. If using Calibre, you have the option of doing it either way. 



Whichever conversion method you use, make sure that you have an image that is large enough. 
Here is the word from Amazon: Image dimensions of at least 500 pixels horizontally and 800 
pixels vertically, with an ideal height/width ratio of 1.6. A maximum of 2000 pixels on the 
longest side is preferred. 

I have usually used 600 x 800 in the past, and I use the same image for both inside the book, 
and for the marketplace. 

Conversion With Calibre 

When you are finished formatting your book, and are preparing to upload it to Amazon’s KDP 
you have some options in the type of file you can use, as we mentioned earlier. You can upload 
your Word .doc, .mobi, Mobipocket’s PRC or HTML(Web, Filtered). 

My recommended method is to upload a MOBI file. There are two ways I like for converting to 
MOBI: Calibre and Kinstant. To create a MOBI file using Calibre, you need two things: 

1. A copy of Calibre (Free download) 
 

2. A Web Filtered .html file (You should already have this.) 

Open Calibre. Once you have the program open, you need to add your book to the Calibre 
library. Here is the main menu bar you will see inside Calibre: 

 

Before you start using Calibre, you should decide where you want your default library to be. 
When I first published this guide, I didn’t realize that was an option. By default, the Calibre files 
go to: Computer>Local Disk (C:)>Users>Username>Calibre Library. You can change that if you 
like, by clicking in the books image in the menu ribbon. You will have the option to 
Switch/create library. If you click on that, you have the option to move the previous library, in 
case you’ve already been using Calibre. 

The next thing you want to do is import a book to convert. Add books is the very first icon on 
the left side of the menu bar. Click on the down arrow next to Add books and you will see 
several options. You want to select the very first option, or: Add books from a single directory. 

A new menu will pop up, that will allow you to search your computer for the location of your 
HTML file. Just navigate to where you saved the file, click on it to highlight and select Open. 



Your file will then load into the Calibre library and you’ll see it listed on the 
screen. 

 

Next, you should fill in the details about your book, such as, Title, Author, or Publisher. You can 
change any of this text by clicking on the text displayed, and begin typing your own. Then just 
hit Enter when you’re done. 

Once the information is accurate, you can continue with converting your book to MOBI. Just 
click on the drop down arrow that is next to the Convert books tab on the main menu bar. From 
the drop down options, choose Convert individually. 

This should open a new window, where you will choose the file type you are converting to. In 
the upper right corner, you’ll see the default option is EPUB. The format we want to convert to 
is MOBI, so select that from the drop down menu. (The file type you are converting from will be 
ZIP. That’s because when you import your HTML file, it will zip up the file before importing it.) 

 

Next you should add your cover image, if you have one. (I strongly suggest that you do have 
one, and that it be 600 x 800 px.) 



To add a cover image, you can click on the button to select your cover image from your hard 
drive. Or, if you added a cover image as the title page in the template, you can simply check the 
box that says Use cover from source file. 

 

 
 

Select Your Options 
Next, you’ll adjust your conversion options using the vertical menu bar on the left. This menu is 
where you’ll find the options that I talked about earlier in the book: changing the preset page 
breaks before the headings, and turning off or moving the extra TOC. 



 
 

To change the page breaks before the headings, click on the Structure Detection option. You 
will be taken to a page where you will see the following: 



 
 

If you remove ONLY this part of the code: or name()='h2' from both of those commands, it will 
page break for heading 1 but not for heading 2. If you want to take the page breaks out 
completely (because you’re doing them yourself in Word) just click on the button that says 
pagebreak, and in the drop down, select none. 

To turn of the extra TOC or move the TOC to the front of the file, look again to the left vertical 
menu. Click on the MOBI Output option: 

 

If you want to turn off the TOC because you want to use the one from the template, check the 
box that says Do not add Table of Contents to book. If you are using Word for MAC or Open 
Office and want Calibre to generate your TOC, check Put generated Table of Contents at the 
start of book instead of end. 



The final option you are going to set from the left vertical menu is the Page Setup. Click on it 
and you will then see a box with 2 lists of options. The default settings are not set for Kindle, so 
you should find the Kindle option in both lists, and select them. 

 

Click Ok, and your book will be converted to MOBI and stored in your Calibre library. It will be 
saved either to wherever you set your library to save, or at the default which is: 
Computer>Local Disk (C:)>Users>Username> Calibre Library. 

The Calibre interface will show you what files you have saved in the library for each book. After 
you have converted to MOBI, it should show Formats: MOBI, ZIP. (See below.) 



 
 

All of those are links. If you click on the file format, it will open the actual file. If you click on 
Click Path to open, it will take you to the folder where the files are saved. 

Conversion With Kinstant 

This section is going to be very short, because conversion with Kinstant is easy! The first thing 
you see when you log into your Kinstant account, is the instruction to upload a file. 

 

Just browse to your Word document on your computer and click to upload. You should see that 
the upload was successful, and an analysis of the file. The analysis shows you the formatting 



issues that the Kinstant software can try to correct. It will also ask you to upload a cover. If you 
don’t, it will insert one of Amazon’s ugly placeholder covers. Make sure your cover is at least 
500 X 800, or the upload will fail. 

Aft 
 

After you have your cover is uploaded you enter your title and author name (can be a pen 
name) then you are given a few more conversion options. 

You should probably leave the defaults as they are, unless you have tabs and line breaks that 
need cleaning up. Also, it’s probably best to leave the Add/Replace TOC checked, unless you’re 
confident that your TOC is properly formatted and will be a functioning TOC. 



 
 

Click on the Generate button to convert your file. You’ll then be taken to a screen to download 
the file, and delete from the server. That’s it – you’re done! 

 
 

Preview Your Book before Uploading 

There is a preview option inside the Kindle publishing platform where you can view your eBook 
after you upload it, but I recommend you preview it before you upload. If you have a Kindle, 
you can view it on that. If not, there are other options. 

You can download the free Kindle Previewer software. This is available directly from Amazon 
and it will be the last download listed on the above page. 

You download the free Kindle for PC app/software from Amazon. Sorry, but 
 

Or you can view the file from your iPhone or Android powered cell phone, if you have the 
Kindle app installed. 

Once you confirm that your eBook looks the way you want it to, you’re ready to upload it to 
Amazon. 



 

Publishing Your Kindle eBook 
 

Go to the Amazon KDP main page. It should look similar to this: 
 

From here, you are going to log in to your KDP account. Don’t worry if you don’t have one, 
Amazon makes signing up really easy. 

 

Sign In and Update Account Information 

Sign in with your regular Amazon account. You will be presented with two pop-up windows 
asking that you accept Amazon’s terms of use. Click the Agree buttons for both windows. They 
will appear one at a time. You should read through those so you know what the terms are. 



If this is your first time using the KDP service, you probably will be prompted to update your 
information. You must complete this step and enter your details in order to begin earning 
money from your Kindle eBook(s). 

They will want your current address, your phone number, your social security number or EIN 
number, and your banking information. 

Your banking information might be optional, but if you would like to be paid by direct deposit, 
you'll definitely want to provide it. That way, you get paid more quickly. There’s no fee for 
direct deposit. Besides, if you choose check you have to wait until you’ve earned more than 
$100 before they mail it. With direct deposit you can receive payment on as little as $10 
earnings 

KDP Select 

Next step is to click the Add a new title button as shown here: 
 

You will be presented with a new window where you will need to decide whether to participate 
in KDP select, and you will also add all of your book details and upload your files, all on one 
page. 



 
 

What is KDP Select, and should you participate? KDP select is a new program that allows you to 
add your eBook to the Kindle Owner’s lending library for 90 days. You are also allowed to offer 
your eBook as a free download for up to 5 days during the 90 day period. 

In return, you will be paid a share of a monthly reserved fund when someone borrows your 
eBook. Some people are making some nice additional money by doing this, but probably the 
biggest benefit from the program is that it gets new exposure for your eBooks. Some Kindle 
authors have also reported that sales go up considerably after doing a free day or two. 

The terms state that you aren’t allowed to have your eBook published on any other DIGITAL 
platform during the time you are participating in KDP select. That includes selling a PDF version 
from your own website. There is no restriction about publishing a physical book at the same 
time. 

You can always sell your eBook on your website, or on Nook after the 90-day period. Keep in 
mind though, that the KDP select program automatically renews, unless you opt out. If you 



decide to publish on another digital platform, you’d need to make sure you cancel KDP Select 
first. 

From what I’m seeing, KDP Select can help boost your initial sales of a new eBook. I’d say try it 
out and see what happens. 

Enter Your Book Details 

Filling in the information about your book is pretty self-explanatory, but I will go through it 
quickly, in case this is your very first time. 

First, enter your title. Be sure not to use all caps, and use the exact title. If you have a subtitle, 
just use a colon between the title and subtitle. 

If your book is part of a series, you’ll be asked to give the series title and the Volume. Edition 
number is used if this book has been published before and is now an updated version. 

 

Next, you’ll give a detailed, but brief description of what your eBook is about. You have up to 
4000 characters that can be used for this. Give this some thought and use the space well, as 



your description is the first place users look to see if they want to buy your book. Convince 
them that they do! 

Next is a button that says Add contributors. You have to add at least one (the author name or 
pen name.) You can add other contributors if applicable. 

Next, select the appropriate for your eBook from the drop down box. Publication Date, 
Publisher, and ISBN are all optional and are not necessary to include when uploading your 
eBook to Amazon. 

In the second section, you are provided with two options: “This is a public domain work” or 
“This is not a public domain work”. 

 

Some people are under the impression that Public Domain work is not allowed on Amazon, but 
that isn’t the case. You are allowed to publish Public Domain work, but only if it is 
differentiated. In other words, you must either be the first person to publish it (not likely,) or 
you must have made significant revision to make it unique. 

To qualify, the work must be: “Translated - A unique translation, Annotated - Contains 
annotations (unique, hand-crafted additional content including study guides, literary critiques, 
detailed biographies, or detailed historical context, or Illustrated - Includes 10 or more unique 
illustrations relevant to the book. Your description must have a bullet list of the revisions.” 

If your eBook is something you have personally researched and written, then you would select 
the second option. You would also select that option if it is something you had commissioned to 
be written. Either way, you own the rights to it. 

Next, you’ll add the categories and keywords for your book. This is a very important section, 
because this is how potential readers will find your book. 

Note that you only get two categories, so choose wisely. Make sure that the categories you 
select are the most likely to bring you potential readers. It’s a good idea to check other books 
similar to yours to see which categories in which they are listed. Once you’ve selected your two 
categories, click Save. 



 
 

For keywords you can go to the search bar in Amazon and type in words related to your topic. 
When Amazon gives you suggested search terms, there are the actual searches that people are 
entering in Amazon. That can give you a very good start on determining your keywords. 

The next step is uploading your book cover. This is the cover image that will be used to display 
your book in the marketplace. By default, it is also the image that will be used inside your 
eBook. If you already included an image in your book’s interior file, uncheck the box that says, 
“the book cover inside your book.” 

 

Your cover image should have a minimum setting of at least 500px wide x 800px long. 
Recommended maximum for the longest side is 2000px. Also be sure to use either a JPG or TIFF 
file extension. When you’re ready, hit Upload image. 

The last part is to finally upload your actual eBook file. Before you upload it, you're asked to 
either enable digital rights management or disable it. 



If you enable it, the book will be protected from being shared. If you want to create a viral book 
that should get to as many people as possible, be sure to disable digital rights management. If 
you want to make sure people will have to purchase your book, you can enable it. 

Once you’ve made your DRM selection, you can now upload your eBook file. Click the Browse 
for book button. Navigate to your eBook file on your hard drive, select it, click Open, then hit 
the Upload book button. 

 

You should then see a message that states “Converting book file to Kindle format” with a little 
animated spinner. Depending on the size of your eBook file, it could take a few moments to 
complete the uploading process. 

While they say you can continue on to the rest of the process, I would recommend that you 
stick around to make sure the book turned out okay. After you've done a few and you know you 
have the system down, you may no longer need to wait. 

If you want to review, or Preview your eBook results after the conversion process, that option 
will be available. I suggest you always Preview your eBook. 

Then finish up by hitting the Save and Continue button in the bottom right corner. 

After you have completed your eBook upload, it’s off to the next step; selecting your Rights & 
Pricing options. 

Rights, Royalties and Pricing 

The first part of this is selecting your Content Rights. You have the choice between worldwide 
and individual territories. I would recommend that you click on "worldwide," unless you prefer 
not to have your book published in certain countries, or unless you want to target it just one 
specific country, or a few select specific countries. 

The next section deals with your Royalty Options. 



 
 

Here, you get to choose whether you want to earn 35% or 70% royalties. Are you wondering 
why anyone would pick 35%? 

Here's the catch: To qualify for the 70% royalty bracket, you need to meet the following two 
criteria: 

1) The work has to be an original work, i.e., it can't be in the public domain* 

2) You must sell your eBook for a price between $2.99 and 9.99 

*If the content is primarily Public Domain work, you will be required to choose 35% royalties. 
However, if you add substantial original content so that your book is not primarily public 
domain, then it would be eligible for 70% royalties. An original translation would not be 
considered to consist primarily of public domain content. 

There is also another "catch" though it is so minor that it hardly even deserves the name 
"catch”. If you choose the 70% royalty bracket, you need to pay for delivery. But delivery costs 
just pennies per book, so it hardly cuts into your increased profits if you go for the higher 
royalty bracket. 



Now I'm sure you're wondering who would want to go for the lower bracket if they could earn 
twice the royalties with the higher one. There are three groups of people who have to use the 
lower bracket: 

a) People who publish public domain works. 

b) People who want lead generation books. 

People who use their eBooks primarily as lead generation tools need to sell them for as low a 
price as possible, which is usually less than $2.99. 

Amazon's minimum price is $0.99, which means you can start uploading all your freebie 
giveaways and sell them for $0.99 to Kindle users. You just won't get more than 35% in royalties 
for them. 

c) People who want to publish premium products. 

If you want to sell a premium product, one that costs more than the allowed $9.99, you will 
need to select the 35% royalty option. 

If none of the above situations apply, price your book between $2.99 and $9.99 and go with 
70%. Check the box to set the UK price automatically based on the US price. 

How Should You Price Your Book? 

Check out the competition and price yours lower rather than higher if you want to go for 
volume. On the other hand, if you have a unique product where there is a hungry market and 
not much competition, you should go with a higher price, perhaps even a premium price as 
mentioned above. Amazon lets you charge up to $200.00! 

Here's something you may want to consider: 

What if you are already selling a product on your own website that's priced higher than the 
Kindle price that would get you sales? Let's say you're selling an eBook for $27 or $37. 

If you want sales and lots of royalties for the Kindle version, you may want to price it at $9.99 or 
even below. 

But won't your other customers feel cheated? Sure they would. Unless... 

You give them more. So while people who buy your book on Kindle can have the basic book for 
$9.99, you can sell the eBook plus the audio version plus some bonuses for $37 or whatever 
other price you choose. 

In fact, you can send people from the Kindle version to your online sales page, and upsell them 
to the expanded version, giving them a coupon for a discount since they already bought the 
Kindle version. 



For more information about pricing your eBooks, you should check out Amazon’s Kindle Pricing 
Page. 

 

At the very bottom of the page is a check box stating that you have the rights to publish the 
content; be sure to click it. Then hit either Save and Publish if you’re ready to go or Save for 
later if you want to make any changes. 

 

Once you Save and Publish, you’ll get a pop-up box that informs you that it may take up to 24 
hours for an English language book to appear in the Kindle store, and 2 to 3 days for a book in 
another language, and then you're prompted to go to your bookshelf to check on the status of 
your book... and submit another one! 

Now pat yourself on the back! You did it. And now that you know how it works, the next Kindle 
book will be much easier and faster. 



 

Conclusion 
 

I hope you’ve enjoyed this guide, and that you’ve learned that formatting a book for Kindle and 
getting it published on Amazon’s KDP is not so hard. The potential for making money selling 
Kindle books is only going to increase, so I hope you’ll use this kit to get started. 

I realize that there is a lot of Kindle information available out there. Some is great, and some is 
not so great. If you decide that you want to take your Kindle knowledge up a notch, choose 
carefully when you choose a course. Make sure the author is someone who is well-respected 
and reliable. 

I’ve provided a resource section at the end of this guide with links to some tools and sites that 
may be helpful to you when you start your Kindle publishing. 

Thanks and Happy Publishing! 
 
 
 

 

Join me in the ever-changing adventure that is Self-Publishing. 
 
 

Make money promoting Kindle Publishing Kit and other Teresa Miller Products: Sign Up To 
Promote! 



 

Recommended Resources 
 

The Kinstant Formatter 

The Kinstant Formatter – Skip all of the confusion of converting files. Kinstant gives you MOBI 
files in an instant! 

 
 

 

Promoting Your Book 

I have included a basic promotion guide with this kit, but please understand that the main focus 
of the Kindle Publishing Kit is formatting and publishing. Here are some resources that can be 
helpful in learning to promote your books. 

Kickstart Kindle Promotion by Amy Harrop – A clear and easy 10-step promotion guide; it 
includes a 37-page PDF guide, 2-video walk-through, a checklist and a bright, attractive 
infographic for a visual reminder of the steps. 

Kindle Review Sniper by Bill Platt, Sam England, and Rob Howard - Reviews sell more books! 
This course will teach you how to get more Amazon-Approved reviews. Completely ethical; you 
can trust these guys. 

 
 

 

Niches For Books 

Kindle Secret Niches Volume 1 by Amy Harrop – I’m quickly learning to love what Amy puts 
out. She’s been a writer and book marketer for a very long time, and her knowledge and 
experience really shine through in her products. 

Kindle Recipe Goldmine by Matt Rhodes – If it hadn’t been Matt Rhodes, I wouldn’t have taken 
a second look. But Matt’s trustworthy, and his product shows how you can still create recipe 
books that won’t get you banned on Amazon! 

 

 

Advanced Kindle Training/Case Studies 

Dennis Becker’s Kindle Case Study – Follow along to while Dennis takes his book from 
published to best seller. The goal is to make a consistent $2000 per month from one book. 

Kindling: Kindle Launch Formula – Geoff Shaw includes content creation, promotion, case 
studies, a ton of insider tips and free updates for life inside this one-time-fee membership. 

Daniel Hall Kindle Webinar – Daniel Hall’s Kindle webinar. He shows how to quickly publish to 
Kindle. The offer at the end is for his complete self-publishing course. It covers everything! 



Kindle, Nook, some Public Domain information. It’s a membership site, and you get lifetime 
access. 

 
 

 
 

Legal 

Legal Pages for Your eBooks – It’s very important to have the right legal pages: copyright, 
disclaimers, etc. in your books. This package covers all types of legal pages for books. (This 
eBook uses one of the versions.) 

 
 

 

Other 

Amazon’s Resources 
Amazon Kindle Publishing Guidelines 

 

Kindle Direct Publishing Help Section 
 

Amazon's Kindle Forums 
 

Main Kindle Direct Publishing Forum 
 

Official Kindle Direct Publishing Forum Section on Formatting 
 

Kindle Previewer software 
 

Kindle for PC app/software from Amazon 
 
 

 

Press Release Sites 
PR Web 

 

Web Wire 
 

Free-Press-Release 
 

Press Method 



PR Free 
 
 

 

Free Information, Tools and Resources 
eBook Architects Kindle Formatting Tips Blog 

 

Declan Conner’s Kindle Formatting Blog 
 

6 Free Ebooks on Formatting For Kindle 
 

Calibre 
 

Make Use Of Calibre Guide 
 

Kindleboards.com 
 

Mobileread.com 
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